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Глава 7  WinPLC7 
 

В главе описывается программирование и симуляция работы ПЛК в 
пакете  WinPLC7 фирмы VIPA. WinPLC7 является удобной 
альтернативой Siemens STEP

®
7 для программирования ПЛК. 

После представления системы и описания порядка установки 
приводится пример создания простого проекта. 

Более подробная информация по использованию WinPLC7 
представлены в он-лайн документации WinPLC7. 

 

 

Раздел     Страница  

Глава 7 WinPLC7 ............................................................................. 7-1 

Представление системы .................................................................... 7-2 

Установка ............................................................................................ 7-3 

Пример разработки проекта .............................................................. 7-4 

Введение 

Содержание 



Глава 7   WinPLC7 Руководство VIPA Серии 300S SPEED7 

7-2 HB140E - CPU - RE_314-2BG03 - Издание 09/18 

Представление системы 
 

WinPLC7 – это программный пакет фирмы VIPA для 
программирования и симуляции работы любых ПЛК, которые 

программируются Siemens STEP
®
7. Пакет позволяет разрабатывать 

пользовательские приложения на языках FBD, LAD и STL. 

Кроме удобства программирования, WinPLC7 имеет встроенный 
симулятор для отладки программ без использования дополнительного 
оборудования. Этот “Программный ПЛК” функционирует как реально 
существующий ПЛК и обеспечивает такую же реакцию на 
возникновение ошибки и диагностические свойства через 
диагностический буфер, USTACK и BSTACK. 

 

Внимание! 

Подробная информация и примеры программ представлены в он-лайн 
документации WinPLC7. 

 

Вместо WinPLC7 возможно также использование SIMATIC Manager 
фирмы Siemens.  

Ниже рассматривается часть руководства по WinPLC7. 

 

 Pentium 233МГц и ОЗУ 64Mbyte  

 Видеокарта с 16 битовой цветопередачей, разрешение не мене 
1024x768 точек. 

 Операционная система Windows 98SE/ME, Windows 2000,  
Windows XP (Home и Professional), Windows Vista 

 

Вы можете получить демо-версию у фирмы VIPA. Без какой-либо 
активации демо-версия позволяет программировать ЦПУ 11x серии 
100V. Для программирования ЦПУ SPEED7 необходима лицензия 
"profi". Активация лицензии осуществляется по сети Интернет. 

Получение WinPLC7 возможно указанными ниже способами: 

 

На сайте www.vipa.de в разделе Service/Downloads можно скачать 
обновления и текущую демо-версию. 

 

Заказной № Описание 

SW211C1DD Однопользовательская лицензия WinPLC7, CD c с 
документацией на немецком языке 

SW211C1ED Однопользовательская лицензия WinPLC7, CD с 
документация на английском языке 

SW900T0LA ToolDemo 
Демо версия VIPA software library, которая может быть 
активирована в дальнейшем 

 

Общее 

     

Альтернатива 

Системные 

требования 

Источники 

Интернет 

CD-диск 
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Установка 
 

Разработка проекта на WinPLC7 для SPEED7 CPU возможна после 
активации версии "Profi" WinPLC7.  

 

Для установки и регистрации WinPLC7 необходимо:   

 Запустить программу установки WinPLC7 с установочного CD-диска 
или дистрибутива, полученного по Интернет. 

 Выбрать требуемый язык. 

 Принять лицензионное соглашение.  

 Назначить директорию для установки, наименование группы и 
запустить установку. 

 

 Запустить WinPLC7. После запуска появится "Demo" диалог. 

 Нажать клавишу <q>. Появится диалог для активации: 
 

 
 

 Заполнить поля: 
Email-Addr (адрес электронной почты), Your Name (Имя) и Serial 
number (серийный номер). Серийный номер указывается на 
наклейке на корпусе CD-диска. 

 Если компьютер подключен к Интернет, то можно послать запрос 
на активацию, нажав на кнопку [Get activation key via Internet]. В 
противном случае, необходимо нажать на кнопку [This PC has no 
access to the internet] и следовать дальнейшим инструкциям. 

 После успешного завершения процедуры регистрации ключ 
активации отобразится в диалоговом окне (при активации по 
Интернет) или будет послан по электронной почте. 

 Ввести ключ активации и нажать кнопку [OK]. Будет активирована 
"Profi" версия WinPLC7. 

 

Для поиска станций в сети Ethernet (accessible nodes) необходимо 
установить WinPCAP драйвер. Этот драйвер находится в директории, 
где установлен WinPLC7. Наименование файла для установки - 
WinPLC7-V4/WinPcap_4_0.exe. Необходимо запустить этот файл и 
следовать инструкциям. 

 

Предварительные 

требования 

Установка    

демо-версии  

WinPLC7  

 

Активация     
"Profi" версии 

Установка 

драйвера 

WinPCAP для 

поиска стации в 

сети Ethernet 
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Пример разработки проекта 
 

В рассматриваемом примере функция FC1 - это часть программы, 
вызываемая из циклического организационного блока OB1. В этой 
функции выполняется сравнение двух переменных (value1 и value2) и, 
в зависимости от результата, формируется значение выхода. 

 

если value1 = value2, то активен должен быть выход Q 124.0  

если value1 > value2 , то активен должен быть выход Q 124.1  

если value1 < value2, то активен должен быть выход Q 124.2  

 

 Вы должны иметь права администратора на Вашем ПК. 

 На ПК должна быть активирована "Profi" версия WinPLC7. 

 ЦПУ и модуль дискретного вывода должны быть установлены и 
подключены. 

 ЦПУ через интерфейс Ethernet PG/OP должен быть подключен к 
Вашей сети Ethernet через коммутатор/маршрутизатор либо 
непосредственно. 

 На ПК должен быть установлен пакет WinPCap. 

 Напряжение питания должно быть подано на ЦПУ и модуль 
дискретного вывода. ЦПУ должен находиться в режиме  STOP. 

 

 Запустите WinPLC7 ("Profi" версию). 

 Создайте и откройте новый проект, выбрав пункт меню File  > 
Open/create a project. 

 

 Для вызова конфигуратора оборудования необходимо перевести 
WinPLC7 из режима Simulator-Mode в режим Offline-Mode. Для того, 
чтобы перейти в этот режим и указать тип подключения через 
Ethernet, выберите из выпадающего списка "Target: TCP/IP Direct". 

 

 Запустите конфигуратор оборудования, нажав на символ . 
Пожалуйста, обратите внимание, что в конфигураторе 
оборудования объект выбирается двойным нажатием.  

 Выберите в Select PLC-System параметр "VIPA SPEED7" и нажмите 
на кнопку [Create]. Будет создана новая станция. 

 Сохраните пустую станцию. Перед сохранением можно добавить 
имя станции и комментарии. 

 Двойным нажатием выберите требуемый ЦПУ в каталоге 
оборудования ЦПУ SPEED7. 

Формулировка 

задания 

Что должно быть 
сделано:  

Предварительные 

требования 

Разработка 

проекта  

Конфигурация 

оборудования  
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 Установите модуль дискретного вывода и назначьте ему адрес  124. 

 Сохраните конфигурацию оборудования. 

 В конфигураторе оборудования двойным нажатием на ЦПУ 
откройте вкладку CPU-Properties. 

 После нажатия на кнопку [Ethernet CP-Properties (PG/OP-channel)] 
откроются свойства коммуникационного процессора CP343. 

 Выберите закладку Common Options (общие свойства). 

 Нажмите на кнопку [Properties Ethernet]. 

 Выберите подсеть "PG_OP_Ethernet". 

 Введите действующий IP адрес и маску подсети. Эти параметры 
можно получить у Вашего системного администратора. 

 Закройте диалоговые окна, нажав кнопку [OK]. 

 Выберите из выпадающего списка, если это не было сделано ранее, 
пункт "Target: External TCP/IP direct".  

 После выбора пункта меню Online > Send configuration to the CPU  
откроется диалог с таким же именем. 

 Нажмите на кнопку [Accessible nodes]. Пожалуйста, обратите 
внимание, что перед использованием этой функции необходимо 
установить WinPCap!  

 Выберите сетевую карту и нажмите на кнопку [Determining 
accessible nodes]. После некоторой паузы появится список станций. 
Ваш ЦПУ с IP адресом 0.0.0.0 также будет в этом списке. Для 
проверки в этом списке будет также отображаться MAC адрес. MAC 
адрес ЦПУ указывается на откидной крышке. 

 Для временной установки IP адреса выберите Ваш ЦПУ и нажмите 
кнопку [Temporary setting of the IP parameters]. Затем введите те же 
самые параметры, которые Вы указали в свойствах CPU и нажмите 
кнопку [Write Parameters]. 

 Подтвердите, что требуется полный перезапуск ЦПУ. IP параметры 
передадутся на ЦПУ и список доступных станций обновится. 

 Выберите Ваш ЦПУ и нажмите кнопку [Confirm]. Вы окажетесь в 
диалоге "Send configuration". 

 

 Выберите Вашу сетевую карту и нажмите кнопку [Send 
configuration]. После небольшой задержки появится сообщение о 
том, что перенос конфигурации оборудования завершен. 

 

Внимание! 

Обычно перенос конфигурации при установленном соединении к ЦПУ 
(online перенос) выполняют из конфигуратора оборудования.  

Из пункта меню With File > Save active station in the WinPL7 sub project 
Вы можете сначала сохранить конфигурацию оборудования как 
системный файл для переноса в дальнейшем в ЦПУ из WinPLC7. 

 

После того, как перенос конфигурации оборудования завершен, к ЦПУ 
можно обращаться по IP  адресу через WinPLC7. 

 

Доступ через 
интерфейс 
Ethernet PG/OP  

Перенос 
конфигурации 
оборудования  
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WinPLC7 предназначен для создания программы ПЛК. Закройте 
конфигуратор оборудования и вернитесь к Вашему проекту в 
WinPLC7. 

Вся логика действий программы ПЛК будет описана внутри в FC1. 

 

 Выберите пункт меню File > Create new block.  

 Введите "FC1" и нажмите кнопку [OK]. После этого в окне 
редактора откроется функция FC1. 

 

В верхней части редактора находится таблица параметров. В 
рассматриваемом примере две целые переменные value1 и value2 
сравниваются между собой. Поскольку внутри функции выполняются 
только операции чтения этих переменных, то они должны быть 
описаны как "in" (входные переменные).   

 Выберите строку "in   -->" в таблице параметров и введите в поле 
Name имя переменной ("value1"). Нажмите на клавиатуре клавишу 
[Enter]. Курсор перейдет на поле задания типа данных. 

 Тип данных может либо вводится непосредственно, либо 
выбираться из списка доступных данных, нажимая [Enter]. Задайте 
тип данных INT и нажмите [Enter]. Курсор перейдет на поле 
комментариев.  

 Введите "1. compare value" ("1. Сравниваемая величина") и нажмите 
[Enter]. Появится новая строка "in -->" и курсор перейдет на поле 
Name. 

 Выполните для входной переменной value2 те же самые действия, 
как и для value1. 

 Сохраните блок. 

 

Созданная таблица параметров показана ниже на рисунке: 

 

 

В соответствии с заданием в зависимости от значения value1 и value2 
должен активироваться соответствующий выход. Для каждой 
операции сравнения будет создана отдельная цепь.  

 Программа будет создаваться на языке FBD (function block diagram-  
диаграмма функциональных блоков). Для представления 
программы в виде FBD, нажмите на символ  FBD, как показано на 
рисунке.  

 

 Встаньте на поле ввода, обозначенное как "empty" (пусто). 
Доступные операции могут быть вставлены в Ваш проект путем 

Программирова-

ние функции FC1 

Создание функции 
FC1 

Создание 
параметров 

Ввод программы  
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перетаскивания из каталога операций или выбрав требуемую 
операцию двойным нажатием в каталоге. 

 Откройте в каталоге категорию "Comparator" ("Сравнение") и 
вставьте оператор "CMP==I" в цепь. 

  

 Выберите вход слева от оператора и вставьте value1. Так как это 
параметры блока, то список параметров можно просмотреть, введя 
символ "#". 

 Наберите "#", и нажмите [Enter]. 

 Выберите соответствующий параметр и подтвердите выбор, нажав  
[Enter]. 

 Выполните те же самые действия для переменной value2. 

Для назначения соответствующего выхода (здесь Q 124.0), выполните 
следующие действия: 

 Выберите выход с правой стороны оператора. 

 

 

 Откройте каталог в категории "Bit logic" (двоичная логика) и 
выберите функцию "--[=]".  Добавление операции "--=" выполняется 
в WinPLC7 по нажатию клавиши [F7]. 

 Для вставленного операнда назначьте выход Q 124.0. 

  

Теперь цепь 1 создана.  
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Для дальнейшего сравнения необходимо добавить оператор  "CMP>I" 
для выхода Q 124.1 и оператор "CMP<I" для выхода Q 124.2. Создайте 
новую цепь для каждого из операторов в следующем порядке: 

 

 Поместите курсор мыши в произвольную позицию в окне редактора 
и нажмите правую кнопку мыши. 

 Выберите из контекстного меню пункт "Insert new network" ("Вставка 
новой цепи"). Откроется диалоговое поле для ввода позиции и 
номера цепи. 

 Выполните действия, как при создании "Network 1". 

 Сохраните FC1, выбрав пункт меню File > Save content of focused 
window, нажав [Strg]+[S]. 

После создания всех цепей, FC1 будет иметь следующую структуру: 

 

 

 

Добавление новой 
цепи  
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Функция FC1 должна вызываться из циклического организационного 
блока OB1.  

 Создайте организационный блок OB1, выбрав пункт меню File > 
Create new block или нажав кнопку [Display OB1] и создайте OB1. 

 Измените представление блока на STL. 

 Наберите "Call FC1" и нажмите на клавиатуре клавишу [Enter]. 
Параметры функции будут вставлены автоматически. Присвойте 
значения параметрам функции, как показано на рисунке: 

 

 Сохраните OB1, выбрав пункт меню File > Save content of focused 
window нажав [Strg]+[S]. 

 

В WinPLC7 существует возможность выполнить тестирование проекта 
в симуляторе. Для этого необходимо выполнить следующие действия: 

 Выберите "Target: Simulator".  

 

 Передайте блоки в симулятор, выбрав пункт меню PLC > Send all 
blocks. 

 Переключите ЦПУ в RUN, выбрав "Switch/Operating mode" и 
выберите в диалоговом окне кнопку [Warm restart]. Вы увидите, что 
ЦПУ переключился из режима STOP в RUN. 

 Чтобы увидеть значение образа процесса, выберите пункт меню 

View > Display process image.  

 Выберите двойным нажатием мыши образ процесса и введите в 
"Line 2" адрес PQB124. Подтвердите ввод, нажав кнопку [OK]. 
Введенный параметр будет отмечен красным цветом, что 
соответствует логической "1". 

 Откройте OB1, нажав кнопку [Display OB1]. 

 Измените значение одной из переменных в вызове FC1, сохраните 
OB1 и передайте код блока в симулятор. В соответствии с 
заданием, образ процесса будет немедленно изменен. Статус 

блока можно показать, выбрав пункт меню Block > Monitoring 
On/Off.  

 

Создание блока 

OB1 

Тестирование 

программы ПЛК в 

симуляторе 
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Дополнительный компонент симулятора – маска ПЛК. В ней ЦПУ 
имеет графическое представление, которое может быть расширено 
модулями ввода/вывода. 

При переключении симулятора ЦПУ в режим RUN, входы могут быть 
активированы мышью, а значение выходов будет отображаться. 

 Откройте маску ПЛК, выбрав пункт меню view > PLC mask. Вы 
увидите графическое представление ЦПУ.  

 При нажатии правой кнопкой мыши на маску ПЛК открывается 
контекстное меню. Выберите "Insert 16-port digital output module" 
("вставьте 16-ти канальный модуль дискретного вывода"). Модуль 
будет отображаться справа от ЦПУ. 

 При двойном нажатии на выходном модуле, откроется диалог 
свойств модуля. Задайте адрес модуля, равный 124. 

 Переключите режим в RUN. На модуле, при выполнении программы 
в симуляторе, вы увидите, что Q124.0 активен. 

 

 

 

 Для передачи программы в ЦПУ установите режим передачи 
"Target: TCP/IP-Direct". 

 Для передачи данных сети Ethernet нажмите кнопку [...] а затем 
кнопку [Accessible nodes]. 

 Выберите Вашу сетевую карту и нажмите кнопку [Determining 
accessible nodes]. После ожидания будет показан список всех 
доступных станций.  

 Выберите ЦПУ, для которого были описаны параметры TCP/IP в 
конфигураторе оборудования и нажмите [Confirm]. 

 Закройте диалог "Ethernet properties", нажав кнопку [OK]. 

 Передайте блоки в ЦПУ, выбрав пункт меню PLC > Send all blocks. 

 Переключите ЦПУ в режим RUN. 

 Откройте OB1, нажав кнопку [Display OB1]. 

 Измените значение одной из переменных в вызове FC1, сохраните 
OB1 и передайте его в ЦПУ. В соответствии с заданием, образ 
процесса будет немедленно изменен. Статус блока можно 

показать, выбрав пункт меню Block > Monitoring On/Off.  

 

Представление 
через маску ПЛК  

Передача 

программы ПЛК в 

ЦПУ и ее 

выполнение  


